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Chapter 1. Introduction and General Information 
 
Thank you for purchasing RealData’s On Schedule, Version 5.0.  We are certain that you will find this 
easy-to-use application to be a powerful and versatile partner in your real estate development work. 
 
Please review this manual and, in particular, read this section completely before you begin working with 
the program.  This introduction will provide you with important information about the program’s 
capabilities. 
 
On Schedule is an advanced spreadsheet model designed specifically for use by developers and lenders 
involved in subdivision, condominium projects and land development.  It might be best described as a 
loan draw scheduler or “economic critical path” program.  With it you can evaluate on a month-by-month 
basis for as many as 120 months: 
 
1. How much of the development loan must be drawn each month to proceed with the project as 

planned; 
2. The status of each group of units with regard to its construction, sale, and settlement; 
3. The amount of the loan that can be repaid out of sale and rent proceeds;  
4. Distributions to partners; and 
5. The overall inflow and outflow of funds. 
 
On Schedule operates in conjunction with Microsoft Excel.  You do not need to be an expert user of your 
spreadsheet software to make effective use of this model.  On the contrary, you can simply “fill in the 
blanks” to produce a complete report in just minutes. 
 
We do assume that you are familiar with some of the basic features and functions of your computer, such 
as connecting and using your printer, starting up your computer and copying files.  With regard to Excel, 
this User’s Guide will review some of its essential functions with which you should be acquainted.  These 
functions include loading, printing, and saving files.  For a detailed discussion of these topics and the 
many additional features of Excel, we recommend that you consult Excel’s documentation. 

New for Version 5.0 
 
Previous releases of On Schedule have been used to analyze housing subdivisions, condominium projects, 
land subdivisions and even single buildings.  Customer feedback has been instrumental in enhancing 
Version 5.0 to add functionality to what was already a very powerful program. New features include: 
 
• Improved partnership analysis where you can list up to 8 partners and their contributions 
• Project Executive Summary report - a one-page overview of the project 
• Partnership Executive Summary report - a one-page, at-a-glance partner pro forma 
• Extended time period for the analysis (120 months instead of 60 months) 
• Increased number of unit types (8 instead of 4) 
• Improved error trapping 
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System Requirements 
On Schedule is an Excel workbook that takes up approximately 6 megabytes of space on your hard disk. 
Each completed analysis that you save will also take up another 6.5 or more megabytes. You can copy 
analyses onto CDs for archive purposes or to reclaim disk space. Other requirements include: 
• Microsoft Excel 2002 or later 
• 700 Mhz computer or greater running Windows 98/NT/2000/XP/Vista 
• 512 MB of RAM or more recommended 
• A laser or ink-jet printer 

Excel 2007 
On Schedule, Version 5.0 is fully compatible with Excel 2007.  Microsoft has extensively reworked the 
user interface in Excel 2007, so if you are used to earlier versions of Excel, it may take you some time to 
learn your way around the Excel 2007 ribbon.  The RealData Menu is still there, but it is difficult to find 
because it is buried under the Add-Ins tab.  To address this, we have added a new ribbon tab called 
RealData, where you will find all the functions that are on the RealData Menu, but with large icons for 
easy access. 
 

 
Figure 1-1 Excel 2007 Ribbon with RealData Tab 

When you save an On Schedule workbook under Excel 2007, the default file type is Excel 97-2003 
Workbook (*.xls).  Another file type is available, Excel Macro-Enabled Workbook (*.xlsm), which takes 
up considerably less disk space.  However, if you use this file type, you may find that when you later try 
to open the workbook, you get this message: “This file contains encrypted macros that have been disabled 
because there is no antivirus software installed that can scan them. To run these macros, remove the 
encryption or permission restrictions on the file.”  This is a known problem that has been reported to 
Microsoft.  Excel 2007 will not enable the macros, even if the workbook is saved in a “trusted” location, 
unless you install antivirus software that can scan encrypted macros via the Microsoft Antivirus API.  See 
http://support.microsoft.com/kb/927150/en-us for more information. 
 
If you are not sure whether your antivirus software can scan encrypted macros, you can do a test in which 
you save a blank On Schedule workbook with file type Excel Macro-Enabled Workbook (*.xlsm).  Then 
try to open the file you just saved.  If macros are enabled (which you can check from the Welcome 
worksheet), then it is safe to use this file type.  Otherwise, you should stick to the default file type, Excel 
97-2003 Workbook (*.xls). 
 
You should not use any file type other than the two mentioned above for saving an On Schedule 
workbook.  In particular, you MUST NOT use file type Excel Workbook (*.xlsx), because this file type 
causes Excel 2007 to remove all of On Schedule’s essential macros. 
 
There is a section in the RealData Knowledge Base specifically dealing with Excel 2007: 
http://www.realdata.com/helpdesk/index.php?pid=knowledgebase#display_entry,false,25 
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Previous Versions of Excel 
On Schedule is also fully compatible with Excel 2002 and Excel 2003.  When you open the software, it 
will automatically detect the version (assuming that macros are enabled) and display the correct menu.  
For the previous versions of Excel, you should see the RealData Menu as shown in Figure 1-5 below. 

License Information 
Please read the license agreement at http://www.realdata.com/p/license.shtml.  By installing the software, 
you accept the terms of the license.  This software is not returnable once you have completed its purchase 
online.  It is also not returnable once you have received it on compact disc or diskette, along with a serial 
number or password.  Please note that you may make backup copies as you need for your own use. 
 

Additional Disclaimers 
In addition to other disclaimers contained in our license agreement and this User’s Guide, be aware that 
RealData, Inc. is not in the business of providing tax, legal, investment or professional advice of any kind. 
The program is not intended for the preparation of tax returns. 
 
The user should also be aware that financial activities outside the investment being analyzed may interact 
with the subject investment to produce tax consequences not anticipated by this program. The program 
does not take into account the impact of other investments, possible liability under the Alternative 
Minimum Tax or the At-Risk Rules. 
 

Files, Worksheets and Reports 

Opening and Using Files and Worksheets  
You may have chosen during the installation to place an icon on the desktop. If so, you can simply 
double-click that icon to start the program. 
 
Alternatively, select Start from the Windows desktop, then Programs and then RealData. From there, 
select On Schedule or any other RealData program you may have installed. 

 
NOTE 

You may see an alert message when you start up On Schedule.  The message 
warns you that you are loading a workbook that contains macros and that 
malevolent individuals can embed viruses in such files to harm your computer.  
Excel displays this message when it loads any file that contains macros. It is not 
reacting to a security threat that it has found in our program. If you obtained your 
On Schedule program directly from RealData or from an authorized dealer or if you 
downloaded it from our secure web site, you have no cause for concern. You must 
select Enable Macros for On Schedule to function.  

 
In Excel versions 2002 and 2003, you must set your macro security level to medium before opening our 
programs. If the security level is set too high, then you will not be prompted to enable macros.   
 
 
 
To change the macro security setting: 

 RealData, Inc. 3 
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1. Open Microsoft Excel. 

2. Select Tools > Macro > Security and select the Security tab.  Set the security to Medium. 

3. Select OK.  You will now be prompted to enable macros when opening the On Schedule program. 

 
In Excel 2007, macro security behaves differently.  When you first open a RealData program in Excel 
2007, you will see a security warning which says, “Macros have been disabled.”  Click on “Options…” 
just to the right.  You will see a dialog box with three radio buttons at the bottom.  We recommend that 
you select the third radio button, “Trust all documents from this publisher,” and then click OK.  
Thereafter, macros in all RealData products will be enabled. 

Regardless of which version of Excel you’re using, when you open the file, you should see the first page 
of an Excel workbook called the Welcome worksheet. The entire analysis resides in this one workbook 
file. The workbook is a collection of worksheets that have been bound together. Each sheet has a specific 
purpose and you “turn” the page to move from one part of the analysis to another.  
 
While each sheet has a purpose, they are all also interconnected and share information. For example, the 
Construction worksheet provides information used on the Development & Absorption worksheet and both 
provide data for the Project Overview Report. The real advantage is that you don’t have to worry about 
keeping any of this straight; the program does it for you. 
 
Moving from one page to another is very simple. Excel uses notebook tabs as a means of guiding you to 
the various sheets that make up a file. A generic Excel workbook has tabs that look like those shown in 
Figure 1-2: 
 

 
 

 
Figure 1-2 Excel Worksheet Tabs 

The On Schedule tabs have meaningful names but they are a bit long, so you won’t be able to see more 
than four or five tabs at a time: 
 

 
 

 
Figure 1-3 On Schedule Worksheet Tabs 

To move to a particular sheet, select its tab.  You can also use the arrows to the left of the tabs to scroll 
through the rest of the tab names. These arrows will take you forward and back through all of the tabs. 
 
If the tabs or any portion of your spreadsheet window ever become hidden from view, you can resize the 
window. Select the middle square in the upper right of the window: 
 

 
 

Figure 1-4 Windows Screen Sizing Buttons 
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If you are still unable to view the worksheet tabs, select Window, then Arrange; then choose Tiled from 
the list.  Select OK.  In Excel 2007, select the View tab in the ribbon, then choose Arrange All in the 
Windows section.  Make sure the Tiled radio button is selected and click OK. 

RealData Menu 
The RealData Menu (Figure 1-5) is added to the Excel menu bar at the far right when you open an On 
Schedule spreadsheet.  It provides quick access to many useful features. 
  
Please see page 2, above, for information about the RealData Menu if you are using Excel 2007. 
 
 
 
 
 
      

 

 
Figure 1-5 Excel Menu Bar with RealData Menu 

 
 
The first item on the RealData menu is Save. After you have given the template a new name (e.g., “54 
Main Street”), use this to save your file as you work on it.  Next is the Save As… choice.  We 
recommend that you immediately use this command to save the template with a new name whenever you 
begin a new analysis.  Doing so will preserve the original blank template of the program.  Should you 
accidentally overwrite the template, you must reinstall the software.   
 
The Worksheets sub-menu displays convenient links to any section of the software.  A second sub-menu, 
User Worksheets, provides functions which can add/delete/rename new, blank worksheets to your 
analysis for your additional calculations. Below that is Print Reports, which allows you to print any of 
13 pre-formatted reports immediately, regardless of which sheet is currently displayed on the screen (for 
more information, see  
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Printing Reports below). Finally, we offer a quick link to the Windows Calculator to help you make 
simple mathematical computations outside of the On Schedule program.   
 
The next section gives you easy access to three valuable tools. The first is the User Guide, which you are
reading right now. It requires Adobe Acrobat® to open. You can obtain the Acrobat Reader free from 
Adobe’s website.  The two items that follow allow you to seek web-based help from us (provided you
connected to the Internet). The first, RealData Web Site, will connect you to 

 

 are 
www.realdata.com, where 

you can check our Knowledge Base and Support section for information that might help you solve a 
articular problem. Contact Technical Support makes it easy to communicate with us if you have a 

Finally, you have the option to Close the program. While Close needs no explanation, be assured that you 
ill be prompted to save your work if you choose this option.  

To print reports, pull down the RealData menu, choose Print Reports and then select the report(s) you 
want to print. 

 
 

p
specific question.  About On Schedule displays a window containing the program version and build, as 
well as user registration information.   
 

w
 
 
 
Printing Reports 

 
 

Figure 1-6 Print Dialog Box 
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You can also print parts of any visible worksheet by pulling down the Excel File menu and choosing 
Print. In Excel 2007, click on the Office Button, then choose Print. You will probably use this method 
only if you want to print a particular range or to s
re

elect printing options that are not part of the standard 
port formats.  Be aware that if you use the Excel Print menu, you will not have any of the built-in On 

Schedule reporting options or layouts available. 
 

On Schedule gives you optionally the ability to create a PDF (portable document 
file) when printing from the RealData menu.  See below for more information.   

 
 

hs to include in your report, up to 120.  Please note that this choice has no effect on 
e Project Overview Report and Partnership Presentation, which are not monthly, nor on the Gantt 

Chart or Graphs. 
 

ck and white or 
color output. To do this, click the Select Printers button in the Print Reports dialog, 
choose your printer from the list and then click the Setup button.   

DF is 
from 

dobe .  Please keep in mind that you may not send your client a copy of the Excel On Schedule 

me worksheet, find “RealData PDF Print Driver,” and click check.  Please 
ote that the RealData PDF Print Driver will work only with those RealData software products that have 

 as described above): 

 initiate printing, choose Select Printer.  See Figure 1-7 below. 

Change RealData. 

at you can logically create only one copy 

Note 

 

The Print Reports Dialog 

The print dialog box gives you a number of options when you are creating reports. It allows you to choose 
which device to print to, the number of copies to print and whether the output should be in color or black
and white.  On Schedule produces a month-by-month pro forma and this dialog also allows you to specify
the number of mont
th

Note 

With some printers, rather than using the “Print in black and white” checkbox, you 
may have to use the printer’s own control panel to configure bla

 

Printing Reports to a PDF 

You can print reports to a PDF and send them to a client or colleague as an email attachment.  A P
an exact digital image of a printed report and can be opened by the Acrobat Reader available free 

®A
workbook. That Excel file is in fact the program, which is licensed only for use by you, the user. 
 
Before you can print reports to a PDF, the RealData PDF Print Driver must be installed. Version 3 of this 
driver is installed automatically as part of On Schedule Version 5.0 installation, but if you are in any 
doubt, you can go to the Welco
n
been enabled for this purpose. 
 
To print reports to a PDF (after the driver has been installed
 
1. Go to the RealData Menu and choose Print Reports 

2. From the Print Dialog Box used to

3. Select PDF-X

4. Select OK.  

5. Select whether you want to print in black and white.  Note th
of a file at a time, so “number of copies” has no effect here. 
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6. Select Print. The program will then begin creating the file. 

7. You will be prompted to name the file and to select a location where it should be saved. Name the fi
something meaningful, like MainStreetCondosCashFlow.pdf or GreenAcresSubdivisionLoan.pdf.  
This fil

le 

e can be saved anywhere on your computer.  Once saved, this file can be easily attached to 
email. 

8. To view your printout, you need the Adobe Acrobat Reader, available at no charge at 
www.Adobe.com (the exact link was http://www.adobe.com/products/acrobat/readstep2.html wh
this guide was published). Once this softw

en 
are is installed, just double-click on the PDF file and 

Acrobat will open the file automatically. 

n Schedule worksheets you are working on or any other program you have open. 

 

 

Note 

The Print Dialog Box lets you easily select the printer you want to use, e.g., the 
RealData PDF Printer. Once you have clicked OK, this printer will remain active for 
this analysis as long as you have it open or until you change the selected printer.  
However, if you close the workbook then the next time you open it, the printer 
choice will revert to the default printer for your computer.  Also be aware that this 
selection only applies to On Schedule; it does not change the printer for any non-
O

 
 

Figure 1-7 Selecting the RealData PDF Print Driver 

Entering Data 
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Each worksheet, except for those designed as report-only, has areas that you will use to enter data. Much 
of the rest of this User’s Guide is devoted to discussing the information that you will enter. Depending 
upon the property you are analyzing, you’ll use some, but probably not all, of the data fields. 
  
Most of the fields in On Schedule are spreadsheet cells containing formulas and formatting that you 
would certainly not want to erase accidentally. On the visible worksheets, we’ve displayed these cells in 
black, locked them, and protected the worksheets without a password to prevent you from accidentally 
changing any formulas or formatting.   
 
On the Tools menu (or Review tab in the Excel 2007 Ribbon) you will find menu choices to unprotect or 
protect the current worksheet.  You should unprotect a worksheet only if you are an experienced Excel 
designer intending to make custom changes.  There are also modules containing proprietary Visual Basic 
macro code.  Do not attempt to unlock the workbook or access the macro code.  The passwords that 
protect these formulas and code are not available to users.  Please recognize also that we cannot provide 
technical support for anything you yourself may create in the user worksheets or for any workbook whose 
sheets have been unprotected. 
 
Throughout the worksheets we have provided quick reminders of important information in “cell notes.”  
You will know that there is a cell note available if you see a little red triangle in the upper right corner of 
the cell.  If you hover your cursor over the cell note indicator, a comment will appear that will provide 
more information about the data you can enter into that cell.  Often the cell note will be at the left end of a 
row, in the cell where the label for that row is located and it will pertain to the entire row. 
 
To make entering information easier, we have also color-coded the data-entry cells. Cells that appear blue 
or purple are generally available for input, as follows: 
• The blue cells are empty or contain 0. They are used for items such as the first-month development 

costs, amount of working capital.  They may also contain labels that you can edit.  
• The purple cells each contain an erasable formula that means, “Use whatever value is in the cell to 

the left.”  These erasable formulas serve as a typing shortcut and can be found in areas where you are 
likely to want to enter the same information for each year.  

For example, the interest rate for the development loan has a blue data-entry cell in the first year (Cell 
D118 in the Development & Absorption worksheet), but purple thereafter. That means you can enter an 
amount in the first month and it will automatically duplicate itself in each subsequent month without your 
having to type it in. If you want to change the rate in the second month, however, you can simply type 
over the formula in that year and enter a new rate—remember we said the formula was “erasable.”  You 
do not have to enter a rate for each month, but only if and when a change occurs.  This new rate will be 
used for each subsequent month until you make another entry in the row. 
 
Keep in mind that you are erasing the unprotected formula whenever you make an entry in a purple cell.  
If you want to restore a particular formula, it is very easy.  Looking again at the development loan, if you 
entered 10.00% in month 2, you would be making that entry in cell E118.  Before you made your entry, 
the cell had a formula that said, “This cell equals the cell immediately to the left.”  Since the cell to the 
left is D118, the formula you erased was simply =D118. Type this in; the cell will once again equal 
whatever rate is used for the previous year. 
 
Note also the button on line 71, “Restore Purple Cells.”  If you decide that you want to go back to “square 
one” in making your development projections and would like to restore all of the purple cells to their 
original formulas, simply press this button to do so. 
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NOTE 

When entering numeric data into the program, always enter numbers only.  Do not 
type dollar signs, commas or letters along with numbers, or you will see the error 
message, “#Value!” in the current or dependent cells. Excel will not recognize 
such entries as numbers and will alert you with this error message, which often 
cascades to cells throughout the program. 

Recalculation and Iteration 
On Schedule is set for automatic recalculation. If you notice that your worksheet does not fill in with 
calculated values as you make each entry, then the automatic recalculation has been turned off.  
 
To turn recalculation back on, select Options from the Tools drop-down menu.  Select the Calculation 
tab. Select Automatic.  In Excel 2007, select the Formulas tab in the Ribbon, then select Calculation 
Options in the Calculation section. 
 
On Schedule, Version 5.0 does not require that iteration be enabled.  The software will function properly 
whether it is on or off.  By default it is off, but you may want to turn it on temporarily if you are copying 
data from an older saved workbook based on Version 4.0 build 1.29 or earlier, which required iteration to 
be enabled. 
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Chapter 2. Welcome and General Info 
The workbook begins with a Welcome page that displays Internet links for technical support, product 
information, instructional articles, newsletter signups and other useful resources.  We urge you to let us 
know of any change in your email or postal address so that we can keep you up to date regarding these 
resources. 

What the General Info Worksheet Does 
The analysis begins with the next sheet, which is called General Info.  On this page you will enter 
information that is used throughout the analysis and on most reports. 

Entering Data in the General Info Worksheet 

Property Information 

The first data field on the General worksheet is “Property Name.” Your entry here will be used in the 
heading or cover page of each of the reports.  Notice the placeholder text, “Property Name Here.”  Be 
sure to type something meaningful in this cell or the placeholder will appear on all of your reports.  This 
field is used only as a label for reports and does not affect the calculations of the program. 
 

 
Figure 2-1 Project Name 

The second field allows you to specify the property type.  Again, this information will appear in various 
reports but will have no effect on any calculations.   

 

 
Figure 2-2 Project Type 

 

Month and Year Analysis Begins, Date of Report 

In the next two fields, you will enter the month and the year that the analysis will begin.  You can type 
directly into the fields, or you can use the up-and down-arrows to raise or lower the numbers.  Your 
entries will pass through to the other worksheets that use this information to perform calculations. Your 
entries define the starting point for an analysis that may go up to 120 months.  
 
The next entry, “Date of this Report,” has no effect on calculations.  It is strictly a label that will appear 
on various reports.  Please note that unlike the other data-entry items on this page, this one appears in 
purple instead of blue.  Purple fields contain formulas that we have purposely left unprotected so that you 
can erase them.  In this case, the field has a formula that reads your computer’s clock and inserts today’s 
date.  If you do not want to use the current date, just type what you want into the cell. 
  

Property Location, Developer, Report Prepared For and By, Lender 

The next several items —“Property Location,” “Developer,” “Report Prepared For,” “Report 
Prepared By,” and “Lender”— are again labels that the software will display on various reports.  Be sure 
to type over or delete any of the placeholder text you see in these fields, otherwise that text will appear on 
your reports. 

 RealData, Inc. 11 
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Discount Rate for NPV Calculations 

The purpose of the Net Present Value (NPV) calculation is to estimate the present worth of the future 
income stream. The rate that you choose accounts for the fact that money received in the future is less 
valuable than money received today.  In this entry, “Discount Rate for NPV Calculations,” you specify 
the discount rate, i.e., how much less valuable is money received 1 year from now than money received 
today. 
 

 
Figure 2-3 Discount Rate for NPV Calculations 
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Chapter 3. Development & Absorption 

What the Development & Absorption Worksheet Does 
The Development & Absorption worksheet is the heart of the On Schedule program.  Here you will enter 
data regarding financing, development costs, development projections, and absorption. 

Entering Data in the Development & Absorption Worksheet 

Equity, Financing, and Transaction Assumptions 
Begin your data entry by entering in cells C6 through C17 your working capital, loan commitment, and 
other items that typically do not vary from month to month. Note that each of these entries has a cell note, 
indicated by a small red triangle, which provides guidance for your data entries. 
 
Working capital is the amount of cash that the developer and his/her co-investors are bringing to the 
project. 
 
Working Capital Held in Reserve specifies how much of the working capital should be held back as a 
reserve (often a lender requirement); the balance will be applied to the development costs. 
 
The Value of Land entry allows for the situation where you already own the land (or land and buildings) 
on which the project will be built and you may wish to treat it as part of your initial equity. Note that you 
can click on the label in cell A8 and choose from two options to describe what you own: “Value of Land 
(if owned and treated as project equity)” and “Value of Land/Impr. (if owned and treated as project 
equity),” the latter for use if there are structures on the property, as you might have with a rehabilitation 
project.  Enter the value of that land and improvements here and the program will add it to your equity 
investment.  The program takes this information into account when performing its internal rate of return 
calculation.   
 
Maximum Loan Commitment is the maximum amount that the developer may draw from the lender.  If 
you check the box below, “This is a revolving loan,” then the program will replenish the amount of 
money you can draw whenever you make payments against the outstanding loan balance.  If you do not 
check this box, then the maximum loan commitment represents the maximum cumulative amount that 
may be drawn during the life of the project. 
 
Pay Off Loan End-of-Month X is an optional data input that instructs the program to pay off the remaining 
balance on the development loan at a specified time. 
 
Your development loan will typically be retired by applying a portion of the proceeds of each sale against 
the loan balance (see row 107).  However, you may retire the loan at any time if you have accumulated 
sufficient cash to do so and also to pay all future development costs. 
 
Your entry here will instruct the program to pay off the outstanding balance of the development loan at 
the end of a specific month.  The funds to retire the loan will be taken from the developer's accumulated 
cash, where a portion of the proceeds of sales and rent has been retained. 
 

 RealData, Inc. 13 



On Schedule User’s Guide 
 

Keep in mind that for this entry to yield a meaningful outcome, you must have sufficient cash to retire the 
loan at the end of the month you specify and you must also have no further need for development loan 
advances in future months. 
 
We recommend that you initially leave this cell set at “120” (the maximum number of months in the 
analysis).  Run the complete analysis and then examine the cash flow and the loan analysis sections to 
determine if there is a reasonable earlier time to retire the loan.  If so, then enter that month here. 
 
Enter the Loan Fee Percentage in cell C12.   This is the number of loan points paid to obtain the 
development loan.  Enter any additional Closing Costs in cell C13. 
 
The percentage entries in cells C14 through C16 prompt the user for fees and commissions related to unit 
sales.   
 
Average Months from Sale to Settlement is the final entry in this section; it asks for the average number of 
months between the sale and settlement for the units in the project.  This entry is the average number of 
months between the date of sale and the date of settlement, when money actually changes hands.  Your 
choices are from 0 to 6 months.  The use of 0 means that units will close and settle in the same month 
construction is completed.  This, of course, implies that units were pre-sold.  Deposit monies are assumed 
to be held in escrow and thus unavailable.  They become part of the cash inflow at the time of settlement. 
 
Figure 3-1 shows the completed Equity, Financing & Transaction Assumptions section. 

 

 
 

Figure 3-1 Equity, Financing & Transaction Assumptions 

 

Unit Type Information 
Just to the right of the Equity, Financing & Transaction Assumptions section is a table where you will 
enter information about up to 8 unit types.  If the project involves selling more than 8 types of units, 
you’ll need to find 2 or more unit types that have similar construction costs, construction times and 
selling prices.  You can then average these together into a single unit type.  Keep doing this until you are 
down to 8 unit types or less. 
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In the first column, enter the name of each unit type.  You can leave the default names, “Unit Type A” 
through “Unit Type H,” or you can choose other names.  The revised names will appear on your reports.  
Of course, you do not need to use all eight unit types but you should start with type A and proceed 
through B, C, D, E, F, G and H in order as you need them.  If no units of a particular type are ever built, 
that unit type will automatically be omitted from the reports. 
 
In the second column, indicate how many months it takes to build a single unit of this type.  Later, on the 
Construction worksheet, you will specify how construction costs are allocated among those months. 
 
The last column (Total Number of Units) is colored black instead of blue, because it is not for data entry.  
The program calculates and displays the total number of each unit type, based on the projections you 
enter in rows 74 to 81. 
 
Figure 3-2 shows the table of unit type information. 

 

 
 

Figure 3-2 Unit Type Information 

 

Site Costs 
In this section you enter site costs, which are costs related to the entire site rather than any one unit.  
There are three subgroups: Land Cost (row 25), Soft Costs (rows 28-47) and Hard Costs (rows 50-69). 
 
You can change the names of any of the categories except Land Purchase Cost, where once again the 
label is actually a pull-down from which you may select one of three choices: “Land Purchase Cost,”  
“Land & Improvements, Purchase Cost” or “Improvements, Purchase Cost.”  You may be buying land 
only or land with improvements; you may be leasing the land and purchasing just improvements.  Keep in 
mind that you may be bringing property to the deal as equity (row 8, above) and also purchasing 
additional property here. 
 
The changes you make to labels in this section will follow through to your reports.  If any row in this 
section totals zero, then neither the label for the row nor the zero total will appear on the “Property 
Overview Report.” 
 
For each category, you can enter a separate amount for each month.  The cells are blue instead of purple, 
so when you enter an amount in one cell, it does not automatically propagate to the right.  This is because 
site costs don’t normally repeat the same amount each month. 
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Figure 3-3 Site Costs 

Development Projections 
In this section, you will schedule the beginning of construction and sales for the units in your project.  
Number of Units Begun is straightforward; enter the number of units begun each month (for each unit 
type) in rows 74 through 81.  Note that column C in each of these rows will show you the total number of 
units you have entered. 
 
On Schedule provides options for estimating the number of sales each month.  Perhaps the simplest 
method is to enter a percentage in row 82.  By entering a figure here, you will cause the program to 
estimate the number of monthly sales as a percentage of the number of units that are completed and 
unsold.  This estimate is, of course, always rounded to the nearest whole number of units.  It applies 
equally to all unit types.   
 
You can also fine-tune how the program calculates the monthly sales numbers by using rows 83 through 
90, labeled Minimum No. of Available Unit Type x Sold Each Month.  Using a simple percentage of the 
available units is usually inappropriate when the number of units becomes small.  The number entered 
here is the minimum number of available units you would expect to sell in a month.  Essentially, this 
combines with "Percent of Available Units Sold Each Month" to produce the following instruction: 
"Estimate the number of units to be sold as X percent of the total available, or Y units, whichever is more; 
however, if there aren't that many units available, then just sell all available units." 
 
Keep in mind that you are selling units that you actually have available (line 128 for the first unit type).  
So, if you don't have any units available to sell in a particular month then this "minimum number of 
available units" has no effect in that particular month.  Such cells appear with gray shading. 
 
If you have a minimum defined for a month when the units available are less than that minimum, you will 
see the cell turn a cautionary yellow.  This does not indicate a problem that you need to fix; it is simply to 
alert you to the fact that your minimum number of units is not available to sell this month. 
 
Rows 99 through 106 ask you to enter an average price for each unit type.  These values copy themselves 
across the row and by default remain unchanged.  You can, however, change the average sales price in 
any month.  Be sure to enter a sales price for every month where sales may occur, as indicated by the 
absence of gray shading.  Often it is easier to enter values for all 120 months to be certain. 
 
Percent Sale Proceeds Applied to Loan Repayment allows you to estimate how much of each sale should 
be applied to pay down your outstanding development loan.  Each month that settlements occur, a certain 
percentage of the funds realized from those settlements will be used to make principal payments on the 
outstanding development loan balance.  The portion not applied to the loan is carried forward to the 
following month and is available to apply toward development costs.  Your entry here is the percentage 
applied to loan repayment for each month.  Once again, be sure to enter a figure in this row for all months 
where sales occur. 
 
The eight entries, Average Construction Cost Per Unit Type (rows 108 – 115), specify the average cost to 
the developer to complete each unit type as described on the Construction worksheet.  The program 
assumes that the cost in any given month to construct a unit will be what you define on the Construction 
worksheet, at least initially.  It enters these values in month 1 (column D) of the projection and also 
copies them automatically into months 2 - 120.  If you believe that your construction costs will not be the 
same at some later point in the project as they were at the beginning, then you can override the 
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construction costs by typing a different amount into any month.  Keep in mind that construction costs are 
only operative in months where construction is actually occurring.  In other words, if you have no units 
being built in months 110 – 120, do not be concerned that the default cost of construction appears in those 
months. 
 
These entries (rows 108 – 115) are used in conjunction with the allocation of monthly costs of 
construction as you define them on the Construction worksheet. The program will calculate the project’s 
total construction costs for a given month by taking the number of units in each phase (i.e. month) of 
construction and multiplying it by the percentage of total cost attributable to that phase. 
 
Rental Revenue accounts for projects where you may receive income from some units during the 
development or redevelopment (e.g., condominium conversion) process.  
 
Percent Rental Revenue Applied to Loan Repayment allows you to use a portion of rental revenue for loan 
reduction.  Each month that rental revenue is received, a certain percentage of that revenue may be 
applied toward the outstanding development loan balance.  The portion not applied to the loan is carried 
forward to the following month and is available to apply toward development costs.  Your entry here is 
the percentage applied to loan repayment for each month. 
   
Last is the entry for Annual Interest Rate on Development Loan. This annual rate will be used to compute 
the amount of interest expense for the given month (1/12th of the annual rate).  Note that this row allows 
you to evaluate the potential impact of fluctuating interest rates. 
 
Row 71 contains a button called “Restore Purple Cells.” In the program as delivered, the purple cells in 
rows 82 to 115 and 117 to 118 contain erasable formulas that save you from the need to make repetitive 
entries.  These formulas copy your first-month entry across the row unless you choose to interrupt that 
repetition by overwriting one or more of the purple cells. 
 
After doing so, you may decide that you would prefer to go back to "square one" in making your 
development projections and would like to restore all of these purple cells to their original formulas. 
Simply press this button to do so. 
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Figure 3-4 Development Projections 
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The Results 
 
In rows 123 and below you can view the results based on the assumptions you’ve entered.  The results 
include a section that forecasts project absorption, another that details a month-by-month cash flow 
forecast, and a third that display the expected progress of your development loan.  Each of these can be 
printed from the RealData Menu under Print Reports. 
 
Note that under Cash Flow Plan, row 262 (Unit Construction Costs) will not be meaningful until you have 
completed the Construction worksheet, and row 272 (Distributions to Partners) will not be meaningful 
until you have completed the Partnership Data worksheet. 
 
Brief examples are shown below. You can find complete sample reports by visiting the On Schedule 
product page at www.realdata.com. 
 

 
 

 
 

Figure 3-5 Project Absorption  
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Figure 3-6 Cash Flow Plan 

 
The column called “Total” is the sum of all the projected monthly amounts to the right. Do not attempt to 
change any cells in the Cash Flow Plan.  These values are calculated and are not intended to be altered 
manually by the user.   
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Figure 3-7 Loan Analysis 
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Chapter 4. Construction 

What the Construction Worksheet Does 
In this worksheet you can itemize 28 categories of construction costs for each unit type. You can also 
specify the approximate timing of your expenditures during the construction process. 
 
Keep in mind that the costs you enter on this worksheet are optional, and represent unit construction costs 
only. 
 

Entering Data in the Construction Worksheet 
Construction Costs by Unit Type 
Enter the total dollar or dollar per square foot amount for each of the construction cost categories in rows 
7 through 34.  A radio button at the top of this section indicates the unit of measure for your entries.  You 
can modify the names of the category titles to suit the needs of your specific project and these titles will 
appear on the printed Construction Cost Report.  Please note that the software automatically sums each 
column and displays the result in row 35; you should not overwrite the formulas in this row.   
 
If you want to change the names of the unit types, you’ll need to go back to the Development & 
Absorption worksheet and make the changes in rows 8 to 15, column E. 
 

NOTE 

Use the construction cost sections only to account for the costs involved in 
building the individual units, such as houses or condominiums.  Enter global site 
costs in the Site Costs section of the Development & Absorption worksheet. 

 
Figure 4-1 shows an example of this section of the worksheet in a project that has two unit types: 
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Figure 4-1 Construction Costs by Unit Type 

Percentage of Unit Construction Cost Allocation 
In this section you will allocate construction costs for a single unit of each type, over the months required 
to build it. 
 
Different types may require different lengths of time to build, so if Unit Type A requires 4 months you 
will make entries in months 1 - 4, and if Unit Type B requires 6 months you will make entries in months 1 
- 6.  The program automatically grays out cells for months beyond the number of months you entered on 
the Development & Absorption worksheet in cells H8 to H15. 
 
Each entry represents the percentage of total unit construction cost allocated to that month of 
construction.  For example, suppose in Development & Absorption cell H8 you indicated that it will take 
4 months to build a typical Unit Type A. You review the unit design with your project manager and 
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decide that you will spend 20% of the total cost in month 1, 30% in month 2, 40% in month 3 and 10% in 
month 4.  You will enter those percentages under Unit Type A in months 1-4, respectively. 
 
Figure 3-2 shows an example of a completed worksheet.  In this example, you are projecting that it takes 
five months to construct a “Unit Type A.”  On average, you expect to spend 25 percent of the $247,800 
construction costs during the first month of building this type of unit, 15 percent each during the second 
and thirds months, 20 percent in the fourth month, and 25 percent in the fifth month.  As you will see in 
the project development section, you may be planning to start a group of units in February, then another 
group in May, and still another in August.  On Schedule will help you sort out your anticipated 
construction costs for each month.  For example, in May you may have costs associated with the first 
group of units being in their fourth month of construction and the second group in their first month of 
construction.  On Schedule will track all of this for you. 

 

 
 

Figure 4-2 Percentage of Unit Construction Cost Allocation 

 

 RealData, Inc. 25 



On Schedule User’s Guide 
 

Chapter 5. Project Overview Report 
This worksheet is designed as a presentation-style report, suitable to give to a lender or partner as a 
summary or overview of your project. You can print this along with all other On Schedule reports by 
pulling down the RealData Menu and choosing Print Reports. 
 
In the printed version of this report, monthly site cost categories that were unused in the analysis of this 
project will not appear. 
 
There are no data entry cells on this worksheet. 
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Chapter 6. Project Executive Summary 
This worksheet is designed as a one-page report, suitable to give to a lender or partner as a summary or 
overview of your project. You can print this along with all other On Schedule reports by pulling down the 
RealData Menu and choosing Print Reports. 
 
There are no data entry cells on this worksheet. 
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Chapter 7. Partnership Data 

What the Partnership Data Worksheet Does 
If your project involves capital raised from investors, you may want to show those individuals not only 
your expectations for the project as a whole but also for their investment.  On this worksheet you can 
enter basic assumptions about the structure of the partnership.  That data will become the basis for three 
reports that you can give to individual partners.   
 
You can list up to 8 limited partners or non-managing members on this worksheet.  You then select one of 
these from a drop-down menu, and the program will automatically tailor the reports for that particular 
limited partner or non-managing member.  
 

Entering Data in the Partnership Data Worksheet 
At the top-left of the sheet you will see buttons that allow you to choose between nomenclature suitable 
for a limited partnership and for a Limited Liability Company. 
 

 
 

Figure 7-1 Type of Partnership 

The Limited Partnership choice will cause “General Partner” and “Limited Partner” to appear in certain 
labels here and on the “Partnership Presentation” worksheet and report.  The LLC choice will cause 
“Managing Member” and “Non-Managing Member” to appear.  For the sake of readability in this section 
of the User’s Guide we will use just the terms General Partner and Limited Partner. 
 
Below the Type of Partnership buttons is a set of check boxes indicating whether you want IRR and NPV 
to appear on the Loan Analysis report and the Partnership Presentation report. 
 

 
 

Figure 7-2 IRR and NPV reporting 

The Loan Analysis report never includes the Limited Partner’s IRR or NPV.  It will include the General 
Partner’s IRR and NPV if the corresponding checkboxes on the bottom are checked.  The Partnership 
Presentation report will include the Limited Partner’s IRR and NPV and the General Partner’s IRR and 
NPV if the corresponding checkboxes are checked. 
 
The section to the right is where you specify the details of the partnership. 
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Figure 7-3 Partnership Details 

At the top, enter the name of the General Partner.  The cell for the allocation of cash to the General 
Partner is colored black instead of blue, so it is not a data entry.  The program automatically calculates 
this cell as whatever is left over after the allocation of cash to all Limited Partners. 
 
The entry labeled “partner to analyze below” is a drop-down menu based on the list of partners in rows 14 
to 21.  Hence, you should fill in this list of partners first.  Enter each partner’s cash and land contribution.  
The quantity entered under "#" should normally be 1, but you may want to set it to more than 1 if Name is 
something generic such as "10% investor." 
 
The program allocates cash flow first to pay preferred returns, then to return capital to all partners and 
finally to distribute the remaining cash to partners (i.e., the profit in excess of the preferred return).  Your 
next entry, cell J8, is that percentage of remaining monthly cash flow to be paid to the entire group of 
Limited Partners.  The program will allocate the balance to the General Partner. 
 
Next, indicate what percentage, if any, is the preferred return for the Limited Partners. 

 
For example, a 5.00% preferred return means that each Limited Partner is entitled to a 5% annual, non-
compounded return on his or her investment before the General Partner receives any return at all. Each 
month, the amount due to the Limited Partner is calculated; if the partnership has not yet returned capital 
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and doesn’t earn enough to pay the 1/12th of 5% percent in a given month, or if there is simply no cash 
distribution planned for a particular month, then the cumulative amount owed to the partner remains due.  
 
Your final row of entries allows you to specify when and to what extent you will distribute cash to the 
partners.  Express the distribution as a percentage of available cash in a given month (row 35) or a dollar 
amount (row 36).  The program shows you how much cash is available each month, net of reserved 
working capital, but you will want to keep in mind that excessive early distributions will probably result 
in the need for additional borrowing and hence for greater interest costs. 
 
Row 35 contains a button called “Restore Purple Cells.” In the program as delivered, the purple cells in 
cells E35 through DS35 contain erasable formulas that save you from the need to make repetitive entries.  
These formulas copy your first-month entry across the row unless you choose to interrupt that repetition 
by overwriting one or more of the purple cells.  See page 19 for more information. 
 
In a development project (as opposed to an income-property investment) you may choose not to distribute 
cash until the project is done.  In that case you would complete the analysis of the project first to estimate 
when it would be done and distribute all of the cash at that time.  If you chose to distribute cash from time 
to time during the project, you would still want to pay attention to the completion date so that you could 
disburse the balance of the funds.  
 

NOTE 

Be sure to look at row 34, Net Cash EOM Before Distributions, and take note of 
what is the last month you have money to distribute.  You should specify on line 35 
for that final month that you will distribute 100% of the available cash.  

  
Remember that cash flows will be distributed according to your specified percentages only after the 
available cash has been used to pay the preferred return and to return capital invested to both the General 
and Limited Partners. Paying the preferred return takes precedence over all other distributions.  If there is 
not enough cash to pay the preferred return when the project is completed, then the Limited Partners 
receive as much of it as they can, to the extent of the funds that are available. In other words, the preferred 
return is not a guaranteed return. 
 
The following is an abbreviated version of this worksheet, showing the first three months of the cash 
available and the planned distributions. 
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Figure 7-4 Partnership Distributions 
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Chapter 8. Partnership Presentation  
 
This worksheet is designed as a presentation-style report, suitable to give to a partner as a summary or 
overview of your project and of the partner’s expected returns. You can print this along with all other On 
Schedule reports by pulling down the RealData Menu and choosing Print Reports. 
 
There are no data entry cells on this worksheet. 
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Chapter 9. Partnership Executive Summary 
This worksheet is designed as a one-page report, suitable to give to a partner as a summary or overview of 
your project and of the partner’s expected returns. You can print this along with all other On Schedule 
reports by pulling down the RealData Menu and choosing Print Reports. 
 
There are no data entry cells on this worksheet. 
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Chapter 10. Gantt Chart and Graphs 
 
The Gantt Chart provides a visual timeline of development activities.  A set of radio buttons at the top 
lets you select a monthly, quarterly or yearly chart.  There is no other data entry on this sheet. 
 
When printing the Gantt Chart report, the software will automatically determine the number of months, 
quarters or years to print.  Only those unit types which contain data will print on the report. 
 
 
 

 
Figure 10-1 Gantt Chart 

 
The Graphs sheet displays six graphs of financial data, such as the cash inflows and outflows shown 
below.  As with the Gantt Chart sheet, there is a set of radio buttons at the top so you can select monthly, 
quarterly or yearly graphs.  There is no other data entry on this sheet. 
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Figure 10-2 Cash Flow Graph 

 
To print either of these two worksheets, pull down the RealData Menu and choose Print Reports. 
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Chapter 11. User Worksheets 
An option within the RealData menu allows you to add user worksheets to your analyses.  To add a 
worksheet, simply open ”RealData” in the top Excel menu and then choose “User Worksheets.”   (See 
Figure 11-1 below.)  The User Worksheets menu also provides options to delete or rename your sheets. 
 
You may use these worksheets for performing incidental calculations or, if you are proficient with Excel, 
to design a subsidiary spreadsheet of your own that you can link into On Schedule. 
 
 
 

 

Figure 11-1 User Worksheets Menu 
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